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Important safety information

Important safety information

This manual contains information and warnings that must be followed by the user for safe operation and to keep the product in a safe
condition.

To safely perform service on this product, see the Service safety summary that follows the General safety summary.

General safety summary

Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it. Carefully read all instructions. Retain these instructions for future reference.

This product shall be used in accordance with local and national codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition to the safety
precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or adjustment.
Before use, always check the product with a known source to be sure it is operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other component manuals
for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury

Use proper power cord

Use only the power cord specified for this product and certified for the country of use. Do not use the provided power cord for other
products.

Ground the product

This product is grounded through the grounding conductor of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output terminals of the product, ensure that the product is properly
grounded. Do not disable the power cord grounding connection.

Power disconnect

The power cord disconnects the product from the power source. See instructions for the location. Do not position the equipment so that it is
difficult to operate the power cord; it must remain accessible to the user at all times to allow for quick disconnection if needed.

Use proper AC adapter

Use only the AC adapter specified for this product.

Connect and disconnect properly

Do not connect or disconnect probes or test leads while they are connected to a voltage source.

Use only insulated voltage probes, test leads, and adapters supplied with the product, or indicated by Tektronix to be suitable for the
product.
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Important safety information

Connect the probe output to the measurement instrument before connecting the probe to the circuit under test. Connect the probe
reference lead to the circuit under test before connecting the probe input. Disconnect the probe input and the probe reference lead from
the circuit under test before disconnecting the probe from the measurement instrument.

De-energize the circuit under test before connecting or disconnecting the current probe.
Observe all terminal ratings

To avoid fire or shock hazard, observe all rating and markings on the product. Consult the product manual for further ratings information
before making connections to the product.

Do not exceed the Measurement Category (CAT) rating and voltage or current rating of the lowest rated individual component of a product,
probe, or accessory. Use caution when using 1:1 test leads because the probe tip voltage is directly transmitted to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.
Do not float the common terminal above the rated voltage for that terminal.

The measurement terminals on this product are not rated for connection to Category Il or IV circuits.

Do not connect a current probe to any wire that carries voltages above the current probe voltage rating.

Do not operate without covers

Do not operate this product with covers or panels removed, or with the case open. Hazardous voltage exposure is possible.
Avoid exposed circuitry

Do not touch exposed connections and components when power is present.

Do not operate with suspected failures

If you suspect that there is damage to this product, have it inspected by qualified service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of the product,
turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged. Do not use probes or
test leads if they are damaged, if there is exposed metal, or if a wear indicator shows.

Examine the exterior of the product before you use it. Look for cracks or missing pieces.
Use only specified replacement parts.

Replace batteries properly

Replace batteries only with the specified type and rating.

Recharge batteries for the recommended charge cycle only.

Wear eye protection

Wear eye protection if exposure to high-intensity rays or laser radiation exists.

Do not operate in wet/damp conditions

Be aware that condensation may occur if a unit is moved from a cold to a warm environment.
Do not operate in an explosive atmosphere

Keep product surfaces clean and dry

Remove the input signals before you clean the product.

Provide proper ventilation

Refer to the installation instructions in the manual for details on installing the product so it has proper ventilation.



Important safety information

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects into any of the
openings.

Provide a safe working environment
Always place the product in a location convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use may result in
serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress injuries.

Use only the Tektronix rackmount hardware specified for this product.

Probes and test leads

Before connecting probes or test leads, connect the power cord from the power connector to a properly grounded power outlet.

Keep fingers behind the protective barrier, protective finger guard, or tactile indicator on the probes. Remove all probes, test leads and
accessories that are not in use.

Use only correct Measurement Category (CAT), voltage, temperature, altitude, and amperage rated probes, test leads, and adapters for
any measurement.

Beware of high voltages

Understand the voltage ratings for the probe you are using and do not exceed those ratings. Two ratings are important to know and
understand:

+  The maximum measurement voltage from the probe tip to the probe reference lead.
+  The maximum floating voltage from the probe reference lead to earth ground.

These two voltage ratings depend on the probe and your application. Refer to the Specifications section of the manual for more
information.

WARNING: To prevent electrical shock, do not exceed the maximum measurement or maximum floating voltage for the
oscilloscope input BNC connector, probe tip, or probe reference lead.

Connect and disconnect properly.

Connect the probe output to the measurement product before connecting the probe to the circuit under test. Connect the probe reference
lead to the circuit under test before connecting the probe input. Disconnect the probe input and the probe reference lead from the circuit
under test before disconnecting the probe from the measurement product.

De-energize the circuit under test before connecting or disconnecting the current probe.

Connect the probe reference lead to earth ground only.

Do not connect a current probe to any wire that carries voltages or frequencies above the current probe voltage rating.
Inspect the probe and accessories

Before each use, inspect probe and accessories for damage (cuts, tears, or defects in the probe body, accessories, or cable jacket). Do
not use if damaged.

Ground-referenced oscilloscope use

Do not float the reference lead of this probe when using with ground-referenced oscilloscopes. The reference lead must be connected to
earth potential (0 V).

Floating measurement use

Do not float the reference lead of this probe above the rated float voltage.
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Service safety summary

The Service safety summary section contains additional information required to safely perform service on the product. Only qualified
personnel should perform service procedures. Read this Service safety summary and the General safety summary before performing any
service procedures.

To avoid electric shock
Do not touch exposed connections.
Do not service alone

Do not perform internal service or adjustments of this product unless another person capable of rendering first aid and resuscitation is
present.

Disconnect power

To avoid electric shock, switch off the product power and disconnect the power cord from the mains power before removing any covers or
panels, or opening the case for servicing.

Use care when servicing with power on

Dangerous voltages or currents may exist in this product. Disconnect power, remove battery (if applicable), and disconnect test leads
before removing protective panels, soldering, or replacing components.

Verify safety after repair

Always recheck ground continuity and mains dielectric strength after performing a repair.

Terms in this manual

These terms may appear in this manual:

A WARNING: Warning statements identify conditions or practices that could result in injury or loss of life.

A CAUTION: Caution statements identify conditions or practices that could result in damage to this product or other property.

Terms on the product

These terms may appear on the product:

+ DANGER indicates an injury hazard immediately accessible as you read the marking.
+  WARNING indicates an injury hazard not immediately accessible as you read the marking.
« CAUTION indicates a hazard to property including the product.
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Symbols on the product

c When this symbol is marked on the product, be sure to consult the manual to find out the nature of the potential

hazards and any actions which have to be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbols(s) may appear on the product.

VAN @ + “ A\

CAUTION Protective Ground Earth Terminal . WARNING Breakable.
Refer to Manual (Earth) Terminal Chassis Ground High Voltage Do not drop.
0 + ® ®

Functional < Connection and Do not connect to or
Standby Earth Terminal Use only on an disconnection to remove from an
N . hazardous bare uninsulated conductor that
insulated wire. wire permitted is HAZARDOUS LIVE.
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Operating safely with battery power

For safe operation, the instrument chassis should always remain at earth ground potential.

WARNING: To avoid electric shock, always use the Tektronix-provided grounding cable when the oscilloscope is operating on
battery power and not connected to the external power supply. The Tektronix-provided grounding cable is not for permanent
usage.

Without a connection between the chassis and earth ground, you may receive a shock from exposed metal on the chassis if you connect
an input to a hazardous voltage (>30 Vrus, >42 V). To protect yourself against possible shock, attach the Tektronix-provided grounding
cable.

The grounding cable is necessary to provide protective bonding between the oscilloscope and a dedicated earthing terminal, in accordance
with the NEC, CEC, and local codes. Consider having a qualified electrician to approve the installation.

The grounding cable shall be connected before powering on the oscilloscope and before attaching the probes to any circuit. Connect the
grounding cable from the ground lug terminal on the side panel of the instrument to a dedicated earthing terminal. Make sure the teeth of
the alligator clip makes good electrical contact and is secured against slipping.

The alligator clip on the grounding cable must be connected to a dedicated earthing terminal, an earthing terminal bar, or identified
equipment grounding points (a rack cabinet for example). Make sure you have a good electrical connection to an appropriate grounding
device that is identified with a Protective Earth symbol, or the word GROUND/GND, or the color green (green ground screw/conductor). If
none of these are present, assume the connection is not earthed.

4

o

3767-003

Always verify that the grounding cable is making good electrical contact by using an ohmmeter or continuity meter between the dedicated
earthing terminal and the ground lug terminal on the side panel of the oscilloscope. Verify again anytime the oscilloscope has been left
unattended.

Make sure the dedicated earthing terminal is located in close proximity to the circuit under test. Keep the grounding cable clear of
heat sources and mechanical hazards such as; sharp edges, screw threads, moving parts, and closing doors/covers. Inspect the cable,
insulation, and terminal ends for damage before use. Do not use a damaged grounding cable. Contact Tektronix for a replacement.

If you choose not to attach the grounding cable, you are not protected against electric shock if you connect the oscilloscope to a hazardous
voltage. You can still use the oscilloscope if you do not connect a signal greater than 30 Vrys (42 Vi) to the probe tip, the BNC connector
center, or the common lead. Make sure all probe common leads are connected to the same voltage.

A WARNING: Hazardous voltages may exist in unexpected places due to faulty circuitry in the device under test.

CAUTION: When operating the instrument on battery power do not connect a grounded device, such as a printer or computer, to
the oscilloscope unless the instrument grounding cable is connected to the earth ground.
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Compliance information

Compliance information

This section lists the safety and environmental standards with which the instrument complies. This product is intended for use by
professionals and trained personnel only; it is not designed for use in households or by children.

Compliance questions may be directed to the following address:

Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

tek.com

Safety compliance

This section lists other safety compliance information.
Equipment type

Test and measuring equipment.

Safety class

Class 1 - grounded product.
Safety certification of plug-in or VXI modules

The safety certification is valid only when installed in an appropriately approved (by a USA NRTL or a Canada Certified Organization)
mainframe.

Pollution degree description

A measure of the contaminants that could occur in the environment around and within a product. Typically the internal environment inside a
product is considered to be the same as the external. Products should be used only in the environment for which they are rated.

+ Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally encapsulated,
hermetically sealed, or located in clean rooms.

+  Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is caused by
condensation must be expected. This location is a typical officelhome environment. Temporary condensation occurs only when the
product is out of service.

+ Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation. These are
sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct sunshine, rain, or direct
wind.

+ Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical outdoor locations.
Pollution degree rating

Pollution Degree 2 (as defined in IEC 61010-1)

Measurement and overvoltage category descriptions

Measurement terminals on this product may be rated for measuring mains voltages from one or more of the following categories (see
specific ratings marked on the product and in the manual).

+  Measurement Category II. For measurements performed on circuits directly connected to the low-voltage installation.
+ Measurement Category . For measurements performed in the building installation.
+  Measurement Category IV. For measurements performed at the source of low-voltage installation.

MS024, MSO22 2 Series Mixed Signal Oscilloscopes Quick Start Manual 1
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Compliance information

Note: Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a measurement
category rating. Other circuits within the product do not have either rating.

Mains overvoltage category rating
Overvoltage Category | (as defined in IEC 61010-1)

Environmental compliance

This section provides information about the environmental impact of the product.

Product end-of-life handling
Observe the following guidelines when recycling an instrument or component:

Equipment recycling Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the
product’s end of life. To avoid release of such substances into the environment and to reduce the use of
natural resources, we encourage you to recycle this product in an appropriate system that will ensure that
most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according to Directives
2012/19/EU and 2006/66/EC on waste electrical and electronic equipment (WEEE) and batteries. For information about
recycling options, check the Tektronix Web site (www.tek.com/productrecycling).

Battery recycling This product contains a small installed lithium metal button cell. Please properly dispose of or recycle the
cell at its end of life according to local government regulations.

This product may also be packed with a lithium-ion rechargeable battery pack. Please dispose of or recycle
the battery pack at its end of life according to local government regulations.

+ Rechargeable batteries are subject to disposal and recycling regulations that vary by country and region. Always check and follow your
applicable regulations before disposing of any battery. Contact Rechargeable Battery Recycling Corporation (www.rbrc.org) for U.S.A.
and Canada, or your local battery recycling organization.

+ Many countries prohibit the disposal of waste batteries in standard waste receptacles.

+ Place only discharged batteries in a battery collection container. Use electrical tape or other approved covering over the battery
connection points to prevent short circuits.

Perchlorate materials This product contains one or more type CR lithium batteries. According to the state of California, CR
lithium batteries are classified as perchlorate materials and require special handling. See www.dtsc.ca.gov/
hazardouswaste/perchlorate for additional information.

Transporting batteries
The small lithium primary button cell contained in this equipment does not exceed 1 gram of lithium metal content per cell.

The small lithium-ion rechargeable battery that may also be packed with this equipment does not exceed a capacity of 100 Wh per
battery or 20 Wh per component cell. Each battery type has been shown by the manufacturer to comply with the applicable requirements
of the UN Manual of Tests and Criteria Part Ill, Subsection 38.3. Consult your carrier to determine which lithium battery transportation
requirements are applicable to your configuration, including to its re-packaging and re-labeling, prior to reshipment of the product by any
mode of transport.
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Security disclaimer

Security disclaimer

This Software and its associated Equipment are not designed or intended to be usedwith unsecure networks. You acknowledge that use
of the Equipment may rely upon certain networks, systems, and data communication mediums that are not controlled by Tektronix and
that may be vulnerable to data or security breaches, including, without limitation, internet networks used by Your internet providers and
the databases and servers controlled by Your internet providers. Tektronix shall not be liable for any such breaches, including without
limitation, damages and/or loss of data related to any security breach, and disclaims all warranties, including any implied or express
warranties that any content will be secure or not otherwise lost or altered.

For the avoidance of doubt, if You choose to connect this Software or Equipment to a network, it is Your sole responsibility to provide

and continuously ensure a secureconnection to that network. You agree to establish and maintain appropriate measures (e.g., firewalls,
authentication measures, encryption, anti-virus applications, etc.) to protect the Software and Equipment and any associated data against
security breaches including unauthorized access, destruction, use, modification, or disclosure.

Notwithstanding the foregoing, You shall not use any Products in a network with other products or services that are incompatible, insecure
or not compliant with applicable laws.

MS024, MSO22 2 Series Mixed Signal Oscilloscopes Quick Start Manual 13



Preface

Preface

This manual provides product safety and compliance information, describes how to connect and power on the oscilloscope, and introduces
the instrument features, controls and basic operations. See the product Help document for more detailed information. Go to www.tek.com/

warranty-status-search for warranty information.

MS022 and MSO24 Key features and benefits

+  Bandwidths from 70 MHz to 500 MHz

+  2-and 4- analog channel inputs

«10.1" TFT color (1280 x 800 pixels) Capacitive multi-touch display
+ User interface optimized for touch screen use

+ 2.5 GS/s sample rate for half channels and 1.25 GS/s sample rate for all channels

+ 10 M points record length on all channels

+  Battery pack option includes 2 battery slots and hot-swap capability of the batteries within the battery pack module
+ No set limit on the number of math, reference, and bus waveforms you can display (the number of waveforms depends on available

system memory)

+ Integrated options include 16 Channel MSO, 50 MHz Arbitrary Function Generator (AFG), 4 Bit Digital Pattern Generator, a Digital

Voltmeter (DVM), and trigger frequency counter

+ Advanced serial bus triggering and analysis option lets you decode and trigger on industry standard buses
+ Industry standard VESA interface can be used with several accessories offered by Tektronix and it is also compatible with off the shelf

VESA mounts

Documentation

Review the following user documents before installing and using your instrument. These documents provide important operating

information.

Product documentation

The following table lists the primary product specific documentation available for your product. These and other user documents are
available for download from www.tek.com. Other information, such as demonstration guides, technical briefs, and application notes, can

also be found at www.tek.com.

Document Content

Help In-depth operating information for the product. Available from the
Help button in the product Ul and as a downloadable PDF on
www.tek.com/downloads.

Quick Start User Manual Introduction to product hardware and software, installation

instructions, turn on, and basic operating information.

Specifications and Performance Verification Technical Reference

Instrument specifications and performance verification instructions
for testing instrument performance.

Programmer Manual

Commands for remotely controlling the instrument.

Declassification and Security Instructions

Information about the location of memory in the instrument.
Instructions for declassifying and sanitizing the instrument.

Service Manual

Replaceable parts list, theory of operations, and repair and replace
procedures for servicing an instrument.

Upgrade Instructions

Product upgrade installation information.

Table continued...
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Document Content

Rackmount Kit Instructions Installation information for assembling and mounting an instrument
using a specific rackmount.

How to find your product documentation

1. Go to www.tek.com.

2. Click Download in the green sidebar on the right side of the screen.

3. Select Manuals as the Download Type, enter your product model, and click Search.
4,

View and download your product manuals. You can also click the Product Support Center and Learning Center links on the page for
more documentation.

Install option upgrade licenses

Option license upgrades are field-installable licenses that you can purchase after receiving your instrument, to add features to your
oscilloscope. You install option upgrades by installing license files on the oscilloscope. Each option requires a separate license file.

Before you begin
These instructions do not pertain to options that were purchased and pre-installed on your instrument when ordered.

A node-locked license is valid only for the specific model number and serial number of the instrument for which it was purchased; it will not
work on any other instrument. The single license file does not affect options that were factory installed or any other upgrades that you may
have already purchased and installed.

About this task

Note: You can only install a Node Locked option license one time. If you need to reinstall an uninstalled Node Locked license,
contact Tektronix Customer Support.

Procedure

Follow the instructions you received to download the upgrade license file (<filename>.lic).
Copy the license file or files to a USB memory device.

Insert the USB drive into the powered-on oscilloscope for which the upgrade was purchased.
Select Help > About.

Select Install License to open the Browse License Files dialog box.

Find and select the upgrade license file to install.

Select Open. The oscilloscope installs the license and returns to the About screen. Verify that the installed license was added to the
Installed Options list.

Repeat steps 5 through 7 for each upgrade license file that you purchased and downloaded.
Power cycle the oscilloscope to enable the installed upgrades.

10. If you installed a bandwidth upgrade, rerun signal path compensation (SPC). Then carefully remove the model/bandwidth label from
the lower-left corner of the front panel and install the new model/bandwidth label that was sent through normal mail channels as part
of the upgrade purchase.

N o gk~ ooDbd =
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Check shipped accessories

Make sure that you received everything you ordered. If anything is missing, contact Tektronix Customer Support. In North America, call
1-800-833-9200. Worldwide, visit www.tek.com to find contacts in your area.

Check the packing list that came with your instrument to verify that you have received all standard accessories and ordered items. If you
purchased factory installed options such as a Serial Bus and Triggering option, tap Help > About to confirm that the options are listed in
the Installed Options table.

Item Quantity Tektronix part number
Installation and Safety Manual 1 071-3764-xx

TPP0200 200 MHz, 10x probe One per channel TPP0200

Instrument stand 1 N/A

Power cord 1 Depends on region
Calibration certificate 1 N/A

Report of factory installed licenses 1 N/A

Operating requirements

Use the instrument within the required operating temperature, power, altitude, and signal input voltage ranges to provide the most accurate
measurements and safe instrument operation.

Table 1: Environment requirements

Characteristic | Description

Temperature Operating instrument: 0°C to +50°C (+32°F to 120°F), with 5 °C/minute maximum gradient, noncondensing (NC)
Operating with battery: 0 °C to 45 °C (+32 °F to 113 °F)

For proper cooling, keep the rear of the instrument clear of obstructions for 2 inches (51 mm).

Operating 5% to 90% relative humidity at temperatures up to +30°C,
humidity 5% to 60% relative humidity at temperatures greater than +30°C and up to +50°C.
Operating altitude |Up to 3000 meters (9842 feet)

Battery power Requires 2-BATPK battery pack with 2 slots for batteries to be ordered with instrument or 2-BP battery pack with 2
slots for batteries to be ordered post instrument purchase

Supports up to 2 TEKBAT-XX Li-lon rechargeable batteries. Operating time; Up to 3 hours single battery and up to 6
hours dual batteries.

Tektronix recommends using the TEKCHG-XX external battery charger to charge the TEKBAT-XX batteries in
ambient environments greater than +30°C.

Table 2: Power requirements

Characteristic Description

Power source voltage 24V DC

Power source current 25A
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Input signal requirements

Keep the input signals within allowed limits to ensure the most accurate measurements and prevent damage to the analog and digital
probes or instrument.

Make sure that input signals connected to the instrument are within the following requirements.

Input Description

Analog input channels and AUX In, 1 MQ 300 VRums
setting, maximum input voltage at BNC

Measurement Category I
Digital input channels, maximum input Observe probe ratings
voltage range at digital inputs P6316 Digital Probe

Check that the instrument passes power-on self tests

Power-on self tests verify that all instrument modules are working correctly after power up.

Procedure

1. Power on the instrument and wait until the instrument screen appears.
2. Select Utility > Self Test from the top-edge Menu bar to open the Self Test configuration menu.
3. Check that the status of all power-on self tests are Passed.

If one or more power-on self tests shows Failed:

1. Power cycle the instrument.
2. Select Utility > Self Test. If one or more power-on self tests still shows Failed, contact Tektronix Customer Support.

Connecting probes to the instrument

Probes connect the instrument to your device under test (DUT). Use a probe that best matches your signal measurement needs.

@SS S

N

Connect a BNC passive probe or cable by pushing it onto a channel BNC bayonet connector and turn the lock mechanism clockwise until it
locks.

Rackmount option information
An optional rackmount kit lets you install the oscilloscope in standard equipment racks.

Please refer to your product's datasheet at www.tek.com for more information on rackmount options.
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Getting acquainted with your instrument

The following content provides a high-level description of the instrument controls and user interface. Refer to the instrument help for
detailed information on using the controls and user interface to display waveforms and take measurements.

Front panel controls and connectors

The front panel controls provide direct access to key instrument settings such as vertical, horizontal, trigger, cursors, and zoom. The
connectors are where you input signals with probes or cables.

Tektronix

vig

-Q\

3764-001
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Description

1 |Use the Acquisition controls to start and stop waveform acquisition, enable making a single waveform acquisition, calculate the
average of all the samples for each acquisition interval, and delete the current acquisitions and measurement values from memory.

2 |Use the Multipurpose Knobs (A, B) to move cursors, adjust the zoom, and set parameter values in configuration menu input fields.

3 |Use the Trigger controls to force a trigger event at a random point in the waveform and capture the acquisition, set the amplitude
level that the signal must pass through to be considered a valid transition, and set how the instrument behaves in the absence or
presence of a trigger event.

4 |Use the Horizontal controls to move the waveform from side to side on the screen, and set the time per major horizontal graticule
division and samples/second parameters for the oscilloscope.

5 |Use the Vertical controls to move the selected waveform up or down on the screen, set the amplitude units per vertical graticule
division of the selected waveform, turn on (display) or select channels, and add or select a math, reference (saved), bus, and digital
waveform on the Waveform view.

6 |Use the Miscellaneous controls to turn touchscreen capability off, restore the oscilloscope settings to the default settings,
automatically display a stable waveform, and save files or settings (using the current File > Save As settings).

7 | After connecting the supplied power cord, use the power button to power the instrument on and off. The power button color indicates
the following instrument states; amber is standby, blue is on, unlit is off.

When the batteries in the 2-BP battery pack on your instrument have a low battery charge and the power cord is not connected, the
power button will blink twice and then your instrument will turn off.

Table continued...
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Description

8 |The AFG/AUX Out BNC connector is multiplexed. You must select either AFG or Aux Out to use this connector.

AFG is the signal output for the optional Arbitrary Function Generator (AFG) feature. AUX Out generates a signal transition on a
trigger event or outputs a synchronization signal from the AFG.

9 |Pattern Generator (PG) is a signal output for four Digital signals.

10 | Use Ground and probe compensation connectors to provide a ground connector to help reduce electrostatic damage (ESD) and
adjust the high-frequency response of a passive probe.

11 |Auxiliary trigger input (Aux in) is a connector to which you can connect an external trigger input signal. Use the Aux In trigger signal
with the Edge trigger mode.

12 | Use the Probe connectors to connect BNC passive probes and BNC cables.

Button and knob functions

A description of the functionality of each button and knob on your instrument.

Button

Description

Run/Stop

Starts and stops waveform acquisition. The button color indicates the acquisition status (green
indicates running and acquiring; red indicates stopped). When stopped, the oscilloscope shows
waveforms from the last completed acquisition. The Run/Stop button on the screen also shows the
acquisition status.

Single/Seq

Enables making a single waveform acquisition, or a specified number of acquisitions (as set in

the Acquisition configuration menu). Pushing Single/Seq turns off Run/Stop mode and takes a
single acquisition. The button color indicates the acquisition status (quick green flash indicates single
acquisition acquired; solid green indicates waiting for trigger event). Pushing Single/Seq again takes
another single acquisition.

Clear

Deletes the current acquisitions and measurement values from memory.

A and B knobs

The multipurpose knobs A and B move cursors and set parameter values in configuration menu input
fields. Selecting an menu field that can use a multipurpose knob assigns the indicated knob to change
the value in that input field. The ring around each knob lights when you can use that knob to do an
action. Push a multipurpose knob to enable the Fine mode for making smaller increment changes.
Push the knob again to close Fine mode.

Force

Forces a trigger event at a random point in the waveform and captures the acquisition.

Level

Sets the amplitude level that the signal must pass through to be considered a valid transition. The
color of the Level knob LED indicates the trigger source except for dual-level triggers. The Level knob
is not available when the trigger type requires two level settings or other trigger qualifiers (set from

the Trigger configuration menuy). Push the knob to set the threshold level to 50% of the peak-to-peak
amplitude range of the signal.

Mode

Sets how the instrument behaves in the absence or presence of a trigger event.

Auto trigger mode enables the instrument to acquire and display a waveform whether or not a
trigger event occurs. If a trigger event occurs, the instrument displays a stable waveform. If a trigger
event does not occur, the instrument forces a trigger event and acquisition and displays an unstable
waveform.

Normal trigger mode sets the instrument to acquire and display a waveform only when there is a valid
trigger event. If no trigger occurs, the last waveform record acquired remains on the display. If no last
waveform exists, no waveform is displayed.

Table continued...
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Button

Description

Horizontal Position

Moves the waveform and graticule side to side on the screen (changing the trigger point position in the
waveform record). Push the knob to center the trigger event to the center graticule on the Waveform
view.

Horizontal Scale

Sets the time per major horizontal graticule division and samples/second parameters for the
oscilloscope. Scale applies to all waveforms. Push the knob to enable the Fine mode for making
smaller increment changes. Push the knob again to close Fine mode.

Vertical Position

Moves the selected waveform (Channel, Math, Reference, Bus) and its graticule up or down on the
screen. The color of the knob indicates which waveform the knob is controlling. Push the knob to set
the threshold level to 50% of the peak-to-peak amplitude range of the signal.

Vertical Scale

Sets the amplitude units per vertical graticule division of the selected waveform. The scale values are
shown on the right edge of the horizontal graticule lines, and are specific to the selected waveform in
both Stacked or Overlay modes (in other words, each waveform has its own unique vertical graticule
settings regardless of display mode). The color of the knob indicates which waveform the knob is
controlling.

Channel buttons

Turn on (display), select, or turn off Channel, Math, Reference, or Bus waveforms. The number of
channel buttons depends on the instrument model. If the channel is not displayed, pushing a Channel
button turns on that channel to the Waveform view. If the channel is on the screen and is not selected,
pushing that channel's button selects that channel. If the channel is on the screen and is also selected,
pushing that channel's button turns that channel off (removes it from Waveform view).

Math

Adds or selects a Math waveform on the Waveform view. If no Math waveform exists, pushing the
Math button adds a Math waveform to the Waveform view and opens the Math configuration menu. If
only one Math waveform is displayed, pushing the button turns off the Math waveform (removes it from
Waveform view). Push the button again to display the waveform. If two or more Math waveforms are
displayed, pushing the button cycles through selecting each math waveform.

Ref

Adds or selects a Reference (saved) waveform on the Waveform view. If no Reference waveform
exists, pushing the button opens the Browse Waveform Files configuration menu. Navigate to and
select a waveform file (*.wfm) and tap Recall to load and display the reference waveform. If only one
Reference waveform is displayed, pushing the button turns off the Reference waveform (removes it
from the Waveform View). Push the button again to display the waveform. If two or more Reference
waveforms are displayed, pushing the button cycles through selecting each Reference waveform.

Bus

Adds or selects a bus waveform on the Waveform view. If no Bus waveform exists, pushing the button
adds a Bus waveform to the Waveform view and opens the Bus configuration menu. If only one Bus
waveform is displayed, pushing the button turns off the Bus waveform (removes it from Waveform
view). If two or more Bus waveforms are displayed, pushing the button cycles through selecting each
Bus waveform.

Digital

Adds or selects a digital waveform on the Waveform view. If no digital waveform exists, pushing the
button adds a digital waveform to the Waveform view and opens the digital configuration menu. If only
one digital waveform is displayed, pushing the button turns off the digital waveform (removes it from
Waveform view). If two or more digital waveforms are displayed, pushing the button cycles through
selecting each digital waveform.

Autoset

Automatically displays a stable waveform.

Default Setup

Restores the oscilloscope settings (such as; horizontal, vertical, scale, position) to the factory default
settings.

Touch Off

Turns touch screen capability off. The button is lighted when the touch screen is turned off.

Table continued...
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Button Description

Save Save is a one-push save operation that uses the current File > Save As settings to save screen-shots
(including open menus and dialog boxes), waveform files, instrument settings. If a File > Save or File
> Save As operation has occurred since the last instrument start-up, pushing the button saves the file
types to the location last set in the Save As configuration menu. If no file save operation has occurred
since the last instrument start-up, pushing the button opens the Save As configuration menu. Select
a tab to choose the type of file to save (such as; Screen Capture and Waveform), set any associated
parameters, and where to save it, and select OK. The specified file or files are saved. The next time
you push the button, the same type files are saved. Screen Captures save the entire screen, including
most displayed configuration menus and dialog boxes.

Rear and side panel connections

The rear and side panel connections supply power to the instrument and provide connectors for network, USB devices, digital probes,
battery pack, and instrument stand.

8

7
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Description

1 [Use the digital probe connector to connect the P6316 Logic Probe.

2 |Use the USB Device port to connect to a PC to remotely control the oscilloscope using the USBTMC protocol.
3 |Use the LAN connector (RJ-45) to connect the oscilloscope to a 10/100 Base-T local area network.
4

5

Use the two USB Host ports to connect a USB memory device, keyboard, or mouse

The ground lug external chassis ground point allows you to connect your instrument chassis to a ground reference. Use the ground
lug when the instrument is operating on power from the optional battery pack accessory. Attach an anti-static wrist strap to the
ground lug to reduce electrostatic damage (ESD) while you handle or probe the DUT.

Table continued...
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Description

6

To power the instrument, connect the supplied power cord to the power connector slot on the side of the instrument. Then connect
the power cord to the appropriate AC mains source and use the power button. Use only the power cord specified for this product and
certified for the country of use.

To completely remove power from the instrument, disconnect the power cord. Use the power cord latch when removing the power
cord from the power connector.

The power cord has a high force, latching connector to secure the power cord in place. Align the arrow on the latch with the arrow
next to the connector. Push the latch in until the connector is fully seated.

Hold onto the power cord latch and move it away from the power connector slot to disconnect the power cord.

Use the security lock connector to secure the oscilloscope to a work bench or other location with a standard PC/laptop lock cable.

Use the battery interface connector to connect the external battery pack to the instrument. See the instructions that come with the
battery pack for more information.

CAUTION: The battery interface connector is susceptible to Electrostatic Discharge (ESD). Use ESD precautions with
installing or removing the battery pack.

10

Use the VESA mount (100mm x 100mm) screws to mount your instrument to the supplied stand or other compatible VESA
accessories.
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Instrument stand installation

Mount your instrument to the provided stand in three configurations.

Before you begin

Align the stand with the four VESA screw mounts (closest to the label) on the back of the instrument.

Procedure

1. Hand tighten the bottom two screws on the stand to the bottom two VESA screw mounts.
The instrument is now secured to the stand straight up and down.

2. Hand tighten the top two screws on the stand to the top two VESA screw mounts.
The instrument is now secured to the stand at a fifteen degree angle.

3. Turn the instrument upside-down and hand tighten the top two screws on the stand to the bottom two VESA screw mounts.

The instrument is now secured to the stand at a seventy-five degree angle when the stand is laying flat.

MS024, MSO22 2 Series Mixed Signal Oscilloscopes Quick Start Manual
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User interface

The touch screen user interface contains waveforms and plots, measurement readouts, and touch-based controls to access all

oscilloscope functions.
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Description

1 |The menu bar provides menus for typical operations including:

Saving, loading, and accessing files

Undoing or redoing an action

Setting oscilloscope display and measurement preferences
Configuring network access

Running self tests

Erasing measurement and settings memory

Loading option licenses

Opening a Help viewer

2 | The Waveform view area displays analog, digital, math, reference, bus, and trend waveforms. The waveforms include waveform
handles (identifiers), individual vertical graticule scale labels, and trigger position and level indicators. You can set the Waveform
View to stack each waveform vertically in separate graticule, called slices (the default mode), or overlay all the waveforms on

the screen (traditional waveform view). You can also add Measurement Results views (plots) for individual measurements. These
plot views are separate view windows that you can move on the screen by dragging their title bar to a new position.

Table continued...
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Description

3 | The results bar contains controls for displaying cursors, adding callouts, plots, and result tables to the screen. You also are able
to add badges to the results bar. To remove a measurement, search or other badge from the results bar flick-it off screen. The
controls are:

The Cursors button displays on-screen cursors in the selected view. Touch and drag, or use the multipurpose knobs, to move
the cursors. Double-tap on a cursor, or on the cursor readouts, to open a configuration menu to set cursor types and related
functions.

The Callout button adds a callout object to the selected view. Double-tap the callout text to open a configuration menu to change
the type of callout, text and font characteristics. Drag any callout other than bookmark to any location on the oscilloscope screen
view. Bookmarks callout can only be added to wave views and spectrum views.

The Measure button opens a configuration menu from which to select and add measurements to the results bar. Each
measurement you add has a separate badge. Double-tap a measurement badge to open its configuration menu.

The Search button lets you detect and mark a waveform where specified events occur. Tap Search to open a configuration
menu and set the search conditions for analog and digital channels. You can add any number of searches to the same waveform
or to different waveforms. Search badges are added to the results bar.

The zoom icon button at lets you to draw a box on the screen to zoom in on an area of interest, drawing segments for mask
testing, or drawing areas to define visual trigger conditions.

The More... button allows you to select Zoom and Mask.

4 |The settings bar contains the following elements. Tap a channel or waveform button to add it to the screen and display a badge.
Double-tap a badge to open its configuration menu.

System badges for setting Horizontal, Trigger, and Date/Time parameters

Inactive Channel buttons to turn on channels

Add New Waveform buttons to add math, reference, and bus waveforms to the display
Channel and Waveform badges that let you configure the individual waveform parameters

5 | Configuration menus let you quickly change the parameters of the selected user interface item. You can open configuration
menus by double-tapping on badges, screen objects, or screen areas.
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User interface elements

Each area of the user interface has a specific function that helps manage information or controls.
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The Waveform Record View is a graphical high-level view of the overall waveform record length, how much of the record is on the
screen (shown in brackets), the location of key time events including the trigger event, and the current position of waveforms cursors.

If you are displaying a Reference waveform that is shorter than the current acquisition record length, or you are changing the
horizontal time scale while the oscilloscope acquisition is stopped, the brackets change position to show the part of the waveform
record that is being viewed relative to the current acquisition total record length.

YV ———

If cursors are active on a waveform, the Waveform Record View shows the relative cursor positions as small vertical dashed lines.
i ]

When in Zoom mode, the Waveform Record View is replaced with the Zoom Overview.

The Expansion Point icon on the waveform view shows the center point around which the waveform expands and compresses when
changing horizontal settings.

The Trigger Position Indicator shows where the trigger event occurred in the waveform record. The trigger icon is displayed in the
waveform slice that is the trigger source.

The Zoom icon switches zoom on and off. The front panel Multipurpose knobs also turn on zoom mode and change the position and
horizontal size of the Zoom Box.

The Trigger Level Indicator icon shows the trigger level on the trigger source waveform. Some trigger types require two trigger levels.
Measurement and Search badges show measurement and search resullts.

The Results Bar Handle opens or closes the results bar, to maximize waveform screen viewing when needed. To reopen the results
bar, either tap the handle icon or swipe left from the right side of the display.
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The System badges show global instrument settings (Horizontal, Trigger, Run/Stop status, and Date/Time).
9.  The Inactive Channel buttons add channel waveforms to the Waveform view and add an associated Channel badge to the Settings
bar.

The optional AFG button opens the AFG configuration menu to set and enable the AFG output. This button is only present if the AFG
option is installed.

The optional PG button opens the PG configuration menu to set and enable the PG output. This button is only present if the DPG
option is installed.

The optional D15-D0 button opens the digital channel configuration menu to set and enable the digital channel. This button is only
present if the 2-MSO option is installed.

10. Double-tap a badge to open its associated configuration menu. If you add more Channel or Waveform badges than can fit in the
waveform badge display area, tap the scroll buttons at each end of the waveform badge area to scroll and display hidden badges.

11.  The Waveform Handles on each waveform identify the source of that waveform (Cx for channels, Mx for Math waveforms, Rx for
Reference waveforms, Bx for bus waveforms). The waveform handles are at the zero-volt level of the waveform by default. The
currently selected waveform handle is a solid color; unselected waveform handles are outlined.

Double-tapping a waveform handle opens the configuration menu for that waveform.

For digital channels, the waveform handle shows the channel number. Each individual digital signal is labelled D0-D15 and is with a
different color.

Double-tapping a digital waveform handle opens the digital channel configuration menu.

Dragging a digital signal handle over another handle swaps those two signals on the waveform.

Badges

Badges are rectangular icons that show waveform, measurement, and instrument settings or readouts. Badges also provide fast access to
configuration menus. The badge types are Channel, Waveform, Measurement, Search, and System.

Channel and Waveform badges

Channel and Waveform (Math, Ref, Bus) badges are shown in the settings bar, located along the bottom left of the screen. Each
waveform has its own badge. The badges show high-level settings for each displayed channel or waveform. Double-tap a badge to open
its configuration menu.

100 mVidiv 50.5 m\/div

10X Ch1-Ch2
500 MHz

Most Channel and Waveform badges also have Scale buttons, shown by single-tapping the badge. Use the Scale buttons to increase or
decrease the vertical scale setting for that waveform.
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Ch1

100 mV/div
10X

500 MHz

You can drag Channel and Waveform badges to change their position in the Settings bar and open the badge right-click menu to access a
quick-action menu.

There are two ways to delete Channel and Waveform badges.

+ Right-click the badge and turn it off.

+  Flick the badge off the bottom edge of the display to remove it from the Settings bar. Flicking upwards from the bottom edge of the
Settings bar recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Channel badges are listed in the channel order unless you have moved them. Channel badges may also display short error or warning
messages. For more information double-tap the badge to open its configuration menu, or search the instrument Help.

Waveform badges (Math, Ref, Bus) are listed in the order created (unless they have been moved), and are grouped together by type.
Deleting a Waveform badge does not change the order or names of the remaining badges.

Measurement badges

Measurement badges are located in the Results bar. They show measurements or search results. The badge title also shows the
measurement source or sources. To add a Measurement badge, tap the Measure button and select a measurement.

Peak-to-Peak

U': 6.840 V

Double-tap a Measurement badge to open its configuration menu to change or refine settings. The default measurement badge readout
shows the measurement's mean () value.

To add statistical readouts to individual measurement badges, double-tap a measurement badge to open its configuration menu and select
Show Statistics in Badge. The measurement badge displays the standard deviation (o) value. The standard deviation is zero, when the
population is one.

Some Measurement badges also have Navigation buttons, shown by single-tapping the badge.

Fall Time
K1 10.74 ns
Value: 10.2762 n

The < (Previous) and > (Next) buttons center the waveform in the display at the position of the previous or next measurement point in the
record (for measurements that take more than one measurement per acquisition).

The Min' and Max' navigation buttons center the waveform in the display at the minimum or maximum value for that measurement in the
current acquisition.

The prime symbol (') shown on measurement readings and Min/Max buttons indicates that the value shown (or moved to in the case of
Min/Max buttons and waveforms) is from the current acquisition. Lack of a prime symbol means the value is from all acquisitions.

The Measurement badge displays Status and Failures information when pass/fail testing is enabled through the configuration menu. The
Status line shows Pass (green) or Fail (red) according to the conditions defined in the Pass/Fail Testing panel. The number of Failures
are displayed when statistics are shown in the badge. The Pass/Fail status, number of Failures, and the Limit(s) set in the Pass/Fail
Testing panel are available in the Measurement Results table.
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Frequency

Wu': 97.74 MHz
o' 269.1 kHz
M: 100.2 MHz
m: 96.66 MHz
N: 263125
Failures: 1
Status: Fail

Measurement badges are listed in the order created, starting at the top of the Results bar. Deleting a Measurement badge does not
change the order or names of the remaining badges.

You can drag Measurement badges to change their position in the Results bar and open the badge right-click menu to access a
quick-action menu.

There are two ways to delete Channel and Waveform badges.

+ Right-click the badge and turn it off.

+  Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar
recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Pattern Generator badge

The pattern generator badge display in the Settings bar when pattern generator is set to Continuous or Burst mode.
Patt Gen

The pattern generator badge lists the bit rate, amplitude, and pattern definition. If the Pattern Definition is set to Manual, the badge
shows the Bits 3 to 0. If Pattern Definition is set to File, the badge shows the file name. The Burst button displays in the badge when
pattern generator Output is set to Burst.

To delete the pattern generator badge, right-click the badge and select Output > Off.
Mask Test badge

The mask test results and measurement statistics are displayed in the Mask Test badge in the Results bar. The badge is created when the
first segment of a mask is defined.

Mask Test 1
Test 1

Tested: 1017
Passed: 2632

Failed: 754
Cons: 642
Status: Failing
Seg1: 744
Seq2: 754

Badge readout Description
Label (optional readout) A label defined in the badge configuration menu.

Tested The total number of waveforms tested against the mask.

Passed The number of waveforms that contained no samples that violated the mask.

Failed The number of waveforms that contained one or more samples that violated the mask.
Displays in red if greater than or equal to the total failures threshold.

Table continued...
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Badge readout Description

Cons The highest number of consecutively failed waveforms in the test run. Displays in red if
greater than or equal to the consecutive failures threshold.

Status The status of the mask test. It can be On, Off, Passed/Passing (green) or Failed/Failing
(red).

Seg n (optional readout) The number of waveforms that contained one or more samples that violated mask segment
n.

Double-tap a Mask Test badge to open its configuration menu to change or refine settings.
You can drag the badge to change its position in the Results bar and open the badge right-click menu to access a quick-action menu.
There are two ways to delete Channel and Waveform badges.

+ Right-click the badge and turn it off.

+  Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar
recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Waveform Histogram badges
The Waveform Histogram badges are located in the Results bar. The badge title shows the histogram source.

To add the Waveform Histogram badge to Results bar, set the Display to On from the Result Badge menu. Double-tap a Waveform
Histogram badge to open its configuration menu to change settings.

-61.24 ns

Pk-to-Pk: 86.24 ns
Mode:  -5.171 ns
Mean -17.92 ns
Std Dev:  24.86ns

The histogram badge displays the measurements which are checked in the Result Badge menu.
You can drag the badge to change its position in the Results bar and open the badge right-click menu to access a quick-action menu.
There are two ways to delete Waveform Histogram badges.

+ Right-click the badge and select Delete Histogram.

+  Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar
recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Cursor Badges

You can display the cursor readouts in a Cursors badge in the Results bar. The badge contents depend on the cursor in use.

(A) t: 26.800 ms O t 26800 ms Q v 4802V
v: 4.802V © t 31500ms @ v 2936V

© b 31500ms | At: 4700 ms ‘ Av: 1.866 V |
v: 2936V 1/At: 212.76 Hz 1/Av: 5359 mV/s
At: 4700 ms

1/At: 212.76 Hz

Av: 1.866 V
1/Av: 535.9 mV/s

To create a cursor readouts badge, turn on Cursors, double-tap a cursor readout to open its configuration menu, and set the Readouts
mode to Badge.

Note: You can only view cursor readouts in one location at a time; either on the waveform or in a Cursors badge. You cannot
move cursor readouts to a badge for Spectrum View cursors.

You can drag the badge to change its position in the Results bar and open the badge right-click menu to access a quick-action menu.

There are two ways to delete Channel and Waveform badges.
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+ Right-click the badge and turn it off.

« Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar
recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Search badges

Search badges are also shown in the Results bar, below the Measurement badges. A search badge lists the search source, search type,
and the number of search event occurrences in the current acquisition. The instrument marks the waveform where those events occur with
small down-pointing triangles along the top of the waveform graticule. Double-tap a search badge to open its configuration menu to change
or refine search settings.

Cazxrrl 1 E—s

Search: Edge
Events: 4

Search badges are created by tapping the Search button. Use the displayed configuration menu to set the search criteria.

Search badges have < (Previous) and > (Next) Navigation buttons that open the Zoom mode and center the waveform in the display
at the position of the previous or next search mark in the waveform record. Search badge Navigation buttons are only usable when the
oscilloscope is in single acquisition mode. Single-tap a badge to close the Navigation buttons.

Search: Pulse ...
Events: 2

Some searches also provide Min and Max navigation buttons that open the Zoom mode and center the waveform in the display at the
minimum or maximum value for that search event in the current acquisition.

Search badges are listed in the order created. Deleting a Search badge does not change the order or names of the remaining badges.

You can drag Search badges to change their position in the Results bar and open the badge right-click menu to access a quick-action
menu.

There are two ways to delete Channel and Waveform badges.

+ Right-click the badge and turn it off.

+  Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar
recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Deleting mass Measurements/Searches badges at Once
This badge helps you to delete/remove many number measurements or searches, which are in the Results bar.

1. Select and right click on the Measurement/Search badge in the Results bar, which displays the dialog box as shown:

Configure Meas 4...

Delete Meas 4

Delete All Measurements

Controls Description

Configure Measurement/Search Configure Measurement or Search badges

Delete Measurement/Search/Histogram |Deletes the selected Measurement (standard, jitter, power, DDR, etc.)/Search/Histogram
badge in the Results bar.

Table continued...
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Controls Description
Delete All Measurement/Search/ Deletes all the Measurement (standard, jitter, power, DDR, etc.)/Search/Histogram
Histograms badges in the Results bar.

2. When Delete All Measurements is selected, the oscilloscope asks for the confirmation to delete all the measurements/search at a
time.

WARNING

A

3. The dialog box provides you a checkbox that gives the choice to bypass remaining information dialogs.

+ Don’t ask for remaining items: Default is unchecked. If you leave it unchecked and clear the information dialog, then the dialog
will appear again for the next measurement deletion.

+ Ifthe box is checked, it proceeds with deleting the rest of the items without bringing up the dialog box again. The dialog box
appears for each set of measurements you want to delete.

Signal Clipping and Badges

WARNING: Clipping is caused by excessive or dangerous voltage at the probe tip, and/or a vertical scale setting that is not
adequate to display the entire vertical range of the waveform. Excessive voltage at the probe tip can injure the operator and cause
damage to the probe and/or instrument.

This instrument shows a warning triangle symbol and the words Clipping in a Channel badge when a vertical clipping condition exists. Any
measurement badges associated with that channel also indicate a clipping condition by turning the measurement text red and listing the
type of clipping (positive or negative).

50 m\/div Amplitude Frequency
10 X p':>1.824 V W' > 3.475 MHz
500 MHz Pos clipping Pos clipping

To close the clipping message, change the vertical scale to show the entire waveform, disconnect the probe tip from the excessive voltage
source, and check that you are probing the correct signal using the correct probe.

Clipping causes inaccurate amplitude-related measurement results. Clipping also causes inaccurate amplitude values in saved waveform
files. If a math waveform is clipped, it will not affect amplitude measurements on that math waveform.

System badges

System badges (in the settings bar) display the main Horizontal and Trigger settings. You cannot delete System badges.

Horizontal | Trigger @B

RL: 2.5 kpts

Double-tap a System badge to open its configuration menu.

The Horizontal badge also has Scale buttons, shown by single-tapping the badge. Use the Horizontal Scale buttons to increase or
decrease the horizontal time setting.
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Common badge actions

Action Result Example
Single tap Immediate access controls (Scale, Ch
Navigation).
1 V/div
10X
70 MHz
Double tap Configuration menu with access to all || ©)
setings or the badge.
£ k2 (-] -
& WD
N T
Touch and hold  |Right-click menu with single tap
access to common actions. Typical it &l 2 @i
actions include turning off a channel Configure Ch 2...
and deleting a measurement or
search badge. Coupling >
Bandwidth
10X
500 MHz
Flick Flick the badge off the bottom edge of the display to remove it from the Settings bar.
Flick the badge off the right edge of the display to remove it from the Results bar.
Flick from the right or bottom edge to recover a removed badge. This action is only possible within 10 seconds of
badge removal.

Badge selection status

The appearance of a badge indicates its selection status (selected or unselected), or if a measurement needs to be deleted to close a
channel or waveform badge.

Badge type Selected Unselected Turned off or in use
Channel or Ch1
Waveform 100 mV/div 10 V/div
10X 10X
500 MHz
500 MHz

Table continued...
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Badge type Selected Unselected Turned off or in use
Measurement N/A

Fall Time

W' 10.74 ns Peak-to-Peak

Value: 10.2762 n U':6.840 V

(<))

A dimmed Channel badge means the screen waveform is turned off (but not deleted). A dimmed Waveform badge means that the
waveform display is turned off, or it is being used as a source by a measurement and cannot be deleted until the measurement is deleted.

Configuration menus

Configuration menus let you quickly set the parameters for channels, system settings (Horizontal, Trigger), measurements, cursor
readouts, Waveform and Plot views, callout text, and so on.

Double-tap an item (badge, Waveform View or Plot View, cursor readouts, callout text, and so on) to open its configuration menu. For
example, double-tap a Channel badge in the Settings Bar to open its configuration menu.

CHANNEL 1 (©)]

'VERTICAL SETTINGS

e

1o e
el

T |

|
Th1 WMath 2
20 100 m/div [ 501.5 mV/div
1 10X chl-ch2
500 MHz

Selections or values that you enter take effect immediately. Menu contents are dynamic, and can change depending on your selections,
instrument options, or attached probes.

Related settings are grouped into 'panels'. Tap the panel name to show those settings. Changes to panel settings can change the values
and/or fields shown in that panel and other panels.

VERTICAL SETTINGS. >

Tap anywhere outside a configuration menu to close it.

To open Help content for a configuration menu, tap the question mark icon in the upper right corner of the menu.
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Zoom user interface

Use the zoom tools to magnify waveforms to view signal details.

File Edit Utility Sample: 257 Acgs A i
Waveform View
1

Cursors  Callout

m I. | I |, h

92 Meas 1 2

Minimum
11" -898.4 mV/

Maximum
1 950.8 mV
0'20.000 V (N'=1)
M: 960.0 mV
m: 950.8 mV
256

C Horizontal ' Trigger @l i :
230 mV/div | 230 mV/div 10 ps/div /184 mV . >

10 X 10X SR: 1.25 GS/s 21 Dec 2021
500 MHz 500 MHz RL: 125 kpts 1:28:25 AM

3764-010

1. The Zoom Overview shows the entire waveform record. All waveforms are shown in Overlay mode in the Zoom Overview area. Using
pinch and expand gestures on the Zoom Overview waveforms changes the horizontal time base settings.

2. The Zoom Box shows the area of the Zoom Overview to display in the Zoom View (see 5). You can touch and drag the box to move
the area to view. Moving the Zoom Box, or changing its position, does not change the horizontal time base settings.

3. The Zoom icon (in the upper right corner of the Waveform View) switches zoom mode on and off.

4. A zoom box lets you quickly draw a box around an area of interest in the Waveform or Zoom Overview. Drawing a box immediately
puts the oscilloscope into zoom mode. To draw a zoom box, tap the DRAW-A-BOX button (while in Zoom mode), then touch and drag
on the waveform to draw a box waveform. You can continue to draw zoom boxes until you single tap anywhere on the screen or open a
menu.

To toggle between Zoom mode and Mask mode, double-tap the DRAW-A-BOX button and select one of the two options. Search for
the Mask Testing topics in the oscilloscope Help for more information.

5. The Zoom View shows the zoomed waveforms, as marked by the Zoom Box, in the Zoom Waveform Record View. Use pinch and/or
drag options in the zoom view to change the zoomed area of interest. Pinch, expand, and drag gestures in the Zoom View only change
zoom magnification settings and Zoom Box position.

6. Use the Zoom Title Bar controls to adjust the vertical and horizontal size of the zoom area. Click or tap the + or - buttons or use the A
and B multipurpose knobs.

[0 700 i [0 50007% X

In a waveform view, if both Cursor and Zoom are turned on, use the Zoom Box and Cursors button to change the multipurpose knob
functionality. Tap the Zoom Title Bar to assign the knobs to adjust the zoom or tap the Cursors button to assign knobs to adjust the
Cursors.

Double tap the Horizontal Zoom Position or Horizontal Zoom Scale fields to enter a value using a numerical keypad.

To exit the zoom display mode, tap the Zoom icon in the corner of display or tap the X in the Zoom Title Bar.
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Math-FFT or XY plot view zoom
Use the A and B multipurpose knobs to adjust the zoom for Math-FFT or XY plot view.

In a Math-FFT or XY plot view, if A and B multipurpose knobs are assigned to Zoom, the zoom box is highlighted and the multipurpose

knobs within the Zoom Box are enabled.

File Edit Utility Help Sample: 4.135 kAcqgs

Tektronix

Waveform View

Cursors  Callout

Measure = Search

v

I
| Math 1
20 dBm/div

| FFTmag(C...

Horizontal
10 ps/div

SR: 1.25 G5/5
RL: 125 kpts

Trigger

i | [More..

~

24 Jan 2022
12:00:10 PM

1716006

If both Cursors and Zoom are turned on in Math-FFT or XY Plot view, use the Zoom Box and Cursors button to change the multipurpose
knob functionality. Tap the Zoom Box to assign the knobs to adjust zoom or tap the Cursors button to assign knobs to adjust the cursors .

To exit the zoom display mode, tap the Zoom icon in the corner of view or tap the X in the Math-FFT view or XY plot view.

Using the touch screen interface for common tasks

Use standard touch screen actions, similar to those found on smart phones and tablets, to interact with most screen objects. You can also
use a mouse to interact with the Ul. The equivalent mouse operation is shown for each touch operation.

The oscilloscope has a user interface tutorial. Tap Help > User Interface Tutorial to quickly learn the fundamental touch operations.

Table 3: Common touchscreen Ul tasks with mouse equivalents

Task

Touchscreen Ul action

Mouse action

Add a channel, math, reference, or
bus waveform to the screen.

Tap an inactive channel button, Add New Math,
Add New Reference, or Add New Bus button.

Click an inactive channel button, Add New Math,
Add New Reference, or Add New Bus button.

Select a channel, math, reference,
or bus waveform to make it active

Stacked or Overlay mode: Tap the Channel or
Waveform badge.

Stacked or Overlay mode: Left-click the Channel
or Waveform badge.

Stacked mode:; Tap the channel, math,
reference, or bus waveform slice or handle.

Stacked mode: Left-click the channel, math,
reference, or bus waveform slice or handle.

Overlay mode: Tap the channel or waveform
handle.

Overlay mode: Left-click the channel or
waveform handle.

Table continued...
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Task

Touchscreen Ul action

Mouse action

Display scale or navigation
buttons on a badge (waveform,
measurement, search, horizontal).
Not all measurement or search
badges display navigation buttons.

Tap the badge.

Click the badge.

Open a configuration menu on
any item (all badges, views, cursor
readouts, labels, and so on).

Double-tap the badge, view, or other object.

Double-click the badge, view, or other object.

Open a right-click menu (badges,
views).

Touch and hold on the badge, Waveform View,
Plot view, or other screen item until a menu
opens.

Right-click the object.

Close a configuration menu. Some
dialog boxes will not close until you
click an OK, Close, or other button
in the dialog.

Tap anywhere outside the menu or dialog.

Click anywhere outside the menu or dialog.

Move a menu.

Touch and hold the menu title bar or a blank area
in the menu, then drag the menu to new position.

Click and hold the right mouse button on title or
blank area, drag to new position.

Move a callout. Callouts are screen
objects and are not associated with
any particular waveform channel or
slice.

Touch and hold on a callout and quickly start to
drag, then move to new position. Start to move
the callout as soon as selected (highlighted),
otherwise the Ul opens the right-click menu.

Click and hold the right mouse button on the
callout and quickly start to drag, then move to the
new position.

Change horizontal or vertical
settings directly on a waveform.
Vertical changes only apply to

the selected channel or waveform;
horizontal changes apply to all
channels and waveforms.

Tap a badge and use the Scale buttons.

Touch and hold two fingertips on the waveform
view, move them together or apart vertically or
horizontally, lift from screen; repeat.

Left-click a channel, waveform, or Horizontal
badge and click on the Scale buttons.

Increase or decrease the zoom area
while in Zoom mode.

Touch and hold two fingertips on the waveform
view, move them together or apart vertically or
horizontally, lift from screen; repeat.

Click the + or - buttons on the Zoom Title bar.

Click the Draw-a-Box button, draw a box around
the waveform area of interest.

Quickly scroll or pan a waveform or
list.

Touch and drag in the waveform or list.

Click and drag in the waveform or list.

Close or open the Results Bar to
increase the Waveform View area.

Tap on the Results Bar Handle (three vertical
dots in border) or anywhere in the border
between the Waveform View and the Results
Bar.

Click the Results Bar Handle (three vertical dots
in border) or anywhere in the border between the
Waveform View and the Results Bar.

Click and drag the Results Bar divider.

Change the position of badges in
the Settings Bar or Results Bar.

Touch and drag the badge to a new position in
the same bar.

Click and drag the badge to a new position in the
same bar.
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Configure the instrument

Configurations to help operate your instrument efficiently. Refer to the instrument help for additional configuration information.

Download and install the latest instrument firmware

Installing the latest firmware helps ensure that your instrument has the latest features and is taking the most accurate measurements.

Before you begin

Save any important on-instrument files such as waveforms, screen captures, and setups to a USB drive or network. The installation
process does not remove user-created files, but it is recommended to back up important files before an update.

Determine the current version of firmware installed on the instrument using the Help > About menu.
Procedure

To download the instrument firmware and install onto an instrument:

1. Open up a Web browser on a PC and go to www.tek.com/product-support
2. Enter the instrument model number in the search field and click Go.

3. Scroll down the screen and click the Software tab.
4

. If the listed available firmware version (Windows or non-Windows) is newer than what is on your instrument, select and download that
file to your PC.

Copy the downloaded firmware file to a USB drive.
. Insert the USB drive with the firmware file into one of the USB ports on the instrument.
7. Power on the instrument.

o o

For the battery operated instrument, connect the power cord and keep it connected during the upgrade of an instrument firmware.

8. Follow on-screen instructions.
The instrument will take a few minutes to install the new firmware. Do not remove the USB flash drive or power off the instrument
during this time.

What to do next

To confirm the firmware update, locate the version number found in the About window under the Help menu. Confirm that the instrument
firmware version number matches the firmware version number that you just installed.

Set the time zone and clock readout format

Set the time zone to your region so that saved files are marked with the correct date and time information. You can also set the time format
(12 or 24 hour clock).

Procedure

DATE AND TIME

m 24
‘Hour | Hour

Pacific Standard Time v

1. Double-tap the Date/Time badge (bottom-right of screen) to open the configuration menu.
2. To turn off showing the date and time on the screen, tap Display button to Off.
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To turn on date/time display again, double-tap in the blank area where the date/time badge was displayed to open the configuration
menu, and set the Display button to On.

3. Select a time format (12 Hour or 24 Hour).
4. Tap the Time Zone field and select the time zone that applies to your location.
5. Tap anywhere outside of the menu to close it.

Run Signal Path Compensation (SPC)

Run SPC when you first receive an instrument, and at regular intervals, for best measurement accuracy. You should run SPC whenever
the ambient (room) temperature has changed by more than 5 °C (9 °F), or once a week if you use vertical scale settings of 5 mV per
division or less.

About this task

Signal Path Compensation (SPC) corrects for DC level inaccuracies in the internal signal path, caused by temperature variations and/or
long-term signal path drift. Failure to run SPC on a regular basis may result in the instrument not meeting warranted performance levels at
low volts per division settings.

Before you begin
Disconnect all probes and cables from the front-panel channel inputs and rear-panel signal connectors.
Procedure

1. Power on and warm up the instrument for at least 20 minutes.

2. Tap Utility > Calibration.

3. Tap Run SPC. The SPC Status readout shows Running while SPC is running. SPC can take three minutes approximately per channel
to run, so wait until the SPC Status message changes to Pass before reconnecting probes and using the instrument.

CAUTION: You can abort the SPC calibration by tapping Abort SPC. This may leave some channels uncompensated,
resulting in possible inaccurate measurements. If you do abort the SPC, make sure to run the SPC procedure completely
before using the instrument to take measurements.

4. Close the Calibration configuration dialog when SPC has completed.

If the SPC fails, write down any error message text. Make sure that all probes and cables are disconnected and run the SPC again. If
the SPC still fails, contact Tektronix Customer Support.

Compensate the probe

Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. Use this
procedure to adjust probe compensation for probes with a manual adjustment.

The following procedure checks the probe compensation.

1. Connect a supported probe to Channel 1.

2. Connect the probe tip and ground lead of the probe to the PROBE COMP terminals. Connect only one probe at a time to the PROBE
COMP terminals.

3764-005

3. Turn on the Channel 1 and turn off all other channels.
4. Tap File > Default Setup.
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5. Push the Autoset button on the front-panel or tap File > Autoset from the menu bar. The screen should display a square wave with
the levels between approximately 0 V - 2.5V and 1 kHz.

File Edit Utility Help Sample: 265 Acqs

Waveform View
Cursors  Callout

Measure Search

D‘ More...

Ch1 Horizontal

320 mV/div 400 ps/div

1X SR: 50 MS/s

500 MHz RL: 200 kpts 1:18:49 PM

6. Check the shape of the displayed waveform to determine if the probe needs adjusted. If the waveform has a square leading edge and
a flat top and bottom, the probe does not need adjusted. If the waveform leading edge is rounded or has a spike, you need to adjust

the probe compensation.

e

7. Use the probe adjustment tool provided with the probe to adjust the probe until the waveform has as flat a top and bottom as possible.
Remove the adjustment tool before looking at the waveform. Repeat until waveform top and bottom are flat. See your probe manual for
adjustment location and instructions.

8. Repeat these steps for each probe connected to each channel. You must run this procedure every time you move a probe from one
channel to another.

Connect to a network (LAN)

Connecting to a network allows you to remotely access the instrument.

Work with your network administrator to obtain the required information to connect to your network (IP address, Gateway IP address,
Subnet Mask, DNS IP address, and so on).

1. Connect a CAT5 cable from the instrument LAN connector to your network.
2. Select Utility > 1/0 on the menu bar to open the 1/O configuration menu.
3. Obtain or enter the network address information:
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+  If your network is DHCP-enabled, and the IP address field does not already show an address, tap Auto to obtain the IP address
information from the network. DHCP mode is the default mode.

+ If your network is not DHCP-enabled, or you need a permanent (non-changing) IP address for this instrument, tap Manual and
enter the IP address and other values provided by your IT or system administrator resource.

Tap Test Connection to verify that the network connection is working. The LAN Status icon turns green when the instrument
successfully connects to your network. If you have problems connecting to your network, contact your system administration resource
for help.

Connect the oscilloscope to a PC using a USB cable

Use a USB cable to connect the oscilloscope directly to a PC for remote instrument control.

1.

o~ oeDbd

On the oscilloscope, select Utility > I/0 from the menu bar.

Tap USB Device Port Settings.

Confirm that the USB Device Port control is On (default setting).

Connect a USB cable from the PC to the USB Device port on the instrument.

If using the USB connection to remotely control the oscilloscope using GPIB commands, set the GPIB Talk/Listen Address for your
configuration (0 - 30).

Connect a keyboard or mouse

The instrument supports most standard USB-connected keyboards and mice, and wireless-connected keyboards and mice (using a
USB-connected dongle).

Connect a keyboard and/or mouse by connecting their USB cable, or USB dongle, into any available USB Host port. The keyboard or
mouse should work immediately. If it does not, try the following:

1.
2.

Remove and reinsert the USB cable or dongle in the same port.
Insert the USB cable or dongle into a different USB port.

MS024, MSO22 2 Series Mixed Signal Oscilloscopes Quick Start Manual 41



Operating basics

Operating basics

These procedures are an introduction to using the interface to do common tasks. Refer to the instrument help for detailed information on
menu and field settings.

Add a channel waveform to the display

Use this procedure to add a channel signal to the Waveform View.

1. Connect signal(s) to the channel input(s).
2. Tap an Inactive Channel button (in the Settings bar) of a connected channel.

3. Continue tapping Inactive Channel buttons to add more channels (digital or analog). Channels are displayed from lowest-numbered
channel at the top, to highest-numbered channel at the bottom of the view, regardless of the order they were added (in stacked mode).
File Edit Utility Help Sample: 153 Acgs Tekironix

Waveform View
Cursors  Callout

Measure  Search

e More...

Math 1 psfdiv ’
n"f USRI SR: 1.25 GS/s 21 Dec 2021
Bus RL: 12.5 kpts 1:32:39 AM

4. Double-tap a channel badge to open that channel's configuration menu to check or change settings. See Configure channel or
waveform settings on page 43.
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Configure channel or waveform settings

Use the channel and waveform configuration menus to set parameters such as vertical scale and offset, coupling, bandwidth, probe
settings, deskew values, external attenuation values, and other settings.

Before you begin
Prerequisite: There is a channel or waveform badge in the Settings bar.
Procedure

1. Double-tap a Channel or Waveform badge to open a configuration menu for that item.

For example, in a Channel menu, use the Vertical Settings panel to set basic probe parameters such as vertical scale and position,
offset, coupling, termination, and bandwidth limit. Available settings depend on the probe.

CHANNEL 1 ©)

o
 II7 EEEIIO0
EEEDES WD ER

3. Tap the Help icon on the menu title to open the help topic for more information.
4. Tap outside the menu to close the menu.

Autoset to quickly display a waveform

The Autoset function analyzes the signal characteristics and changes the instrument Horizontal, Vertical, and Trigger settings to
automatically display a triggered waveform. You can then make further changes to trigger and horizontal settings to view the waveform
point of interest.

1. Connect the probe with the signal of interest to an available channel.

Double-tap the Trigger badge and set the trigger source to that of the signal of interest.

Connect any other associated signal(s) to available channel input(s).

Add the channel waveforms to the Waveform view. See Add a channel waveform to the display on page 42.

Tap File > Autoset or push the front-panel Autoset button. When using the Stacked Display mode, the instrument analyzes the signal
characteristics of the trigger source channel (analog or digital) and adjusts the horizontal, vertical, and trigger settings accordingly

to display a triggered waveform for that channel. The Vertical scale is adjusted in each waveform slice of all active waveforms to
maximize ADC utilization.

o~ owobd
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File Edit Utility Help Sample: 4.484 kAcgs Tektronix

Waveform View
Cursors  Callout

Measure  Search

B more

B

ch1

200 mVidiv

10X i

500 MHz 15 RL: 10 kpts

When using the Overlay Display mode, the instrument adjusts the horizontal and trigger settings of the trigger source channel to
display a triggered waveform for that channel. Vertical scale and position adjustments for all active channels in Overlay Display mode
are controlled by the Autoset in Overlay Display Mode Optimizes selection in the Autoset panel of the User Preferences menu. If
the selection is Visibility, Autoset vertically scales and positions all active channel waveforms such that they are uniformly spaced on
screen. If the selection is Resolution, Autoset vertically scales and positions all active channel waveforms such that they each use as
much of the ADC's range as possible.

Note: You can set which parameters the instrument can adjust when running an Autoset. Access the Autoset panel in Utility >
User Preferences > Autoset.

Autoset guidelines

+ Autoset displays three or four cycles (depending on the detected signal) with the trigger level near the midlevel of the signal.

+ The trigger is set to type Edge, rising slope, DC coupling.

+ If no channels are displayed before pushing Autoset, the oscilloscope adds Ch 1 to the Waveform view whether it has a signal or not.
+ Autoset ignores math, reference, and bus waveforms.

+ Achannel or waveform with a frequency less than 40 Hz is classified as no signal.

How to trigger on a signal

Use this procedure to open the Trigger menu to select and configure the trigger event type and conditions.

1. Double-tap the Trigger badge on the Settings bar to open the Trigger configuration menu.

2. Select a trigger from the Trigger Type list. The trigger type sets what fields are available in the menu and also updates the illustration
to show a graphic of the trigger type.
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To trigger on a bus, you must first add the bus to the Waveform view. See Add a math, reference, or bus waveform on page 46

A Note: Triggering on buses other than Parallel requires purchasing and installing serial trigger and analysis options.

3. Select the other fields and panels to refine the trigger conditions. The menu fields and trigger graphic updates as you make changes to
the trigger settings. Displayed fields depend on the selected trigger type. Selection changes take effect immediately.

©)

4. Tap the Help icon on the menu title for more information on these settings.
5. Tap outside the menu to close the menu.

Set the acquisition mode

Use this procedure to set the method the instrument uses to acquire and display the signal.

1. Double-tap the Acquisition badge on the Settings bar to open the Acquisition configuration menu.
2. Select the acquisition method from the Acquisition Mode list. Set any other parameters associated with the selected acquisition type.

HorzonTaL TG >

3. Tap the Help icon on the menu title for more information on these settings.
4. Tap outside the menu to close the menu.
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Set Horizontal parameters

Use this procedure to set the horizontal time base parameters such as mode, minimum sample rate, horizontal scale, delay, and trigger
delay time (relative to the center of the waveform record.

1. Double-tap the Horizontal badge on the Settings bar to open the Horizontal configuration menu.

HORIZONTAL

. HORIZONTAL SETTINGS
s
| —

Bo

e Set to
10%
d scord

Reco

ACQUISITION SETTINGS

bl ——

2. Use the menu selections to set horizontal parameters.
3. Tap the Help icon on the menu title for more information on these settings.

Add a math, reference, or bus waveform

Math waveforms let you create new waveforms based on operations between two or more waveforms or by applying equations to
waveform data. A reference waveform is a static waveform record displayed for comparison. Bus waveforms let you view and analyze
serial or parallel data.

There is no set limit to the number of Math, Reference, or Bus waveforms you can add to the Waveform View, other than system physical
memory constraints.

1. Tap the Math Ref Bus > Add New Math, Add New Ref, or Add New Bus button in the Settings bar.

2. The instrument adds the waveform to the Waveform view, adds a Waveform badge to the Settings bar, and opens a configuration
menu. This example shows adding a Math waveform.
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File  Edit  Utility Help Sample: 13.091 kAcqs Tektronix

Waveform View
Cursors  Callout
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3. Use the configuration menus to refine the waveform parameters. Displayed fields depend on the waveform and selections made in the
menu. Selection changes take effect inmediately.

This example shows adding a Math waveform, using the Math Source fields to select Ch 1 and Ch 2 as the waveform sources, set the
math type to Basic math operation, and subtracting channel 2 from channel 1.

4. When adding a Reference waveform, the instrument displays a Recall configuration menu. Navigate to and select the reference
waveform file (*.wfm) to recall, then tap the Recall button. The instrument displays the Reference waveform.

5. Double-tap a math, reference, or bus badge to check or change the waveform settings. See Configure channel or waveform
settings on page 43.

6. Tap the Help icon on a configuration menu title for more information on math, reference, and bus waveform settings.
7. Tap outside the menu to close the menu.

Add a measurement

Use this procedure to select and add measurements.

1. Acquire the channel(s) and/or waveform(s) on which you want to take measurements.
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Edit Utility Help Sample: 28.557 kAcqs Tekironix
Waveform View
Cursors  Callout

Measure Search

Math 1
10.35 mV....
Avg( Ch1 ...

Note: Waveforms do not need to be displayed to be used for measurements, as long as the channel or waveform badge is
on the Settings bar and is acquiring the signal to measure.

2. Tap the Measure button to open the Add Measurements configuration menu or drag the Measure button onto a waveform in the
waveform display area to automatically set the source.

Cursors | Callout

ADD MEASUREMENTS Measure  Search

Source
|mm 1 - ‘ Add

AMPLITUDE MEASUREMENTS

‘if‘\, Amplitude [J‘-\,} Maximum \J“\,] Minimum

(1 eocrores [P Bt L]
I]\/“ Mean [j\/‘“ RMS ,W ACRMS

J J CA5)
=il 1e0 (12 base (A area

TIME MEASUREMENTS >

Note: If the menu shows tabs other than Standard, then optional measurement types have been installed on the
instrument. Select a tab to show the measurements for that option.

3. Tapthe Source field and select the measurement source. The list shows all available sources that are valid for the measurement.

Source 2

mch2

BCch3

och4

@ Math 1
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6.

1.

10.

Select a measurement category panel, such as Amplitude Measurements or Time Measurements, to display measurements for
those categories.

Select a measurement and tap Add to add the measurement to the Results bar. You can also double-tap a measurement to add it to
the Results bar.

ADD MEASUREMENTS

Maamum
' 28.00 mV.

Math 1 v|
J
AMPLITUDE MEASUREMENTS /

Amplitude. 15 Maximum lh,] Minimum
pakioresk | [\ Boe Negatve

Mean RMS ACRMS
[+ o0 [ ease [n area

TIME MEASUREMENTS. >

Select and add other measurements for the current source. Tap the measurement category panels to display and select other
measurements to add.
To add measurements for other sources, select a different source, select a measurement, and add the measurement.

ADD MEASUREMENTS
Mamum -
- 2800 mv

—_—
=

AMPLITUDE MEASUREMENTS

Amplitude ‘@ Maximum Minimum

Peak i Peak poste Negatve

Mean @ RMS AC RMS

FERE (1] pase [nnl area

TIME MEASUREMENTS > -

Tap outside the Add Measurements menu to close the menu.

To further adjust a measurement's settings, double-tap a measurement badge to open a configuration menu for that measurement.
See Configure a measurement on page 49.

Tap the Help icon on the menu title for more information on settings.

Configure a measurement

Use this procedure to add statistical readouts to the measurement badge, display plots for the measurement, and refine measurement
parameters (configuration, global versus local scope of settings, gating, filtering, and so on).

1.

Double-tap a measurement badge to open its Measurement configuration menu.
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Measure | Search

Mea:
Pasitive Overshoot
V' 18.14 %

2. Tap Show Statistics in Badge to add statistical readouts to the measurement badge.

MEAS 1

_ ==

Measure | | Search

&) show statistics in Badge

3. Tap available panel titles to make changes for those categories.

MEAS 1 ©

: Overshoo
1: 100.0 %

4. Use the available fields to refine the measurement conditions. Displayed fields depend on the measurement. Selection changes take
effect immediately. Selection changes can also change fields in other panels.

5. Tap the Help button on the menu title for more information on this menu's settings.
6. Tap outside the menu to close the menu.
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Add a Search

Use this procedure to set search criteria and mark a waveform where those events occur.

You can search on analog and digital signals, math waveforms, and reference waveforms. You can add searches to different waveforms
and multiple searches to the same waveform.

Prerequisite: Display the channel or waveform signal on which to search. The waveform must be displayed to create a search for it.

1. Tap the Search button to open the Search configuration menu.
SEARCH 1

Cursors Callout
ivieasure | Sear

More...

Maximum
p': 16.00 mV
¢':0.000 V (N'=1)

er @B Auto
Copy Trigger Settings Copy Search Settings .
e

2. Use the configuration menu fields to set the search criteria in the same way that you would set for a trigger condition (select the
Search Type, Source, and conditions on which to search).

A Note: You cannot search for sequential events (there is no Sequence search type).

3. The searched waveform is marked with one or more triangles as soon as the search criteria becomes true. Each search uses a
different color for its markers. The example image shows search criteria set to find positive pulse widths that are less than 70 ns wide.

4. To stop showing marks on a waveform, double-tap the Search badge and tap Display to Off.

5. To move the waveform to center marks on the display, push the Run/Stop front panel button to stop acquisition, single-tap a Search
badge, and tap the < or > Navigation button.
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Search: Pulse ...
Events: 2

(J0]

A Note: Navigation buttons are only functional when the oscilloscope acquisition mode is set to Stop.

This opens the Zoom mode and moves the waveform to the previous or next event mark on the waveform.

6. If available for a search, tap the Min or Max button to center the waveform in the display at the minimum or maximum value of the
search events in the waveform record.

7. To return the instrument to normal acquisition mode, push the Run/Stop front-panel button to set it to Run mode.

Delete a Measurement or Search badge

Use this procedure to remove a Measurement or Search badge from the Results bar.

1. Touch and hold the Measurement or Search badge that you want to delete. The instrument opens a right-click menu.
2. Select Delete Meas to delete that badge from the Results bar.

Fall Time
K 10.25 ns

Configure Meas 7...

Delete Meas 7

A Note: You can undo a measurement delete.

3. The second way to delete a Measurement or Search badge is by flicking it off the right edge of the display. Flicking to the left from the
right edge of the display recovers the badge.

A Note: Badge recovery is possible within 10 seconds only of removal.

Change waveform view settings

Use this procedure to change the waveform display mode (Stacked or Overlay), waveform trace interpolation algorithm, waveform
persistence, style and intensity, and graticule style and intensity.

1. Double-tap on an open graticule area to open the Waveform View configuration menu.
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Waveform View

WAVEFORM VIEW

3. Use the other controls to set the waveform interpolation algorithm, waveform point persistence, style, and intensity, and graticule style
and intensity.

4. Tap the Help icon on the menu title to open the Waveform View menu help topic for more information on the waveform view
parameters.

5. Tap outside the menu to close the menu.

Display and configure cursors

Cursors are on-screen lines that you can move to take measurements on specific parts of a waveform or between two different waveforms.
Cursor readouts show both current position values and the difference (delta) between cursors. Polar cursor readouts are available through
the cursor configuration menu for XY plots.

1. Tap the waveform slice (in Stacked mode), or the channel or waveform badge (in Overlay mode) to which you want to add cursors.
2. Tap the Cursors button. The cursors are added to the display.
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3. Use Multipurpose Knobs A and B to move the cursors, or touch and drag a cursor. Cursors show readouts that show position and
difference measurements between the cursors.

4. To move the cursors to a different channel or waveform, just tap in that waveform graticule.
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5. To further configure cursors, double-tap on either cursor line or the cursor readouts to open the Cursors configuration menu. For
example, tap the Cursor type to select the cursors to display, such as Waveform, V Bars, H Bars, and V&H Bars.

The cursor configuration menu in the waveform view.
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CURSORS ©)

A 20mv B) 3.02v

6. To split the cursors between two waveforms, tap the Source field and select Split and select the source for each cursor. The cursors

are moved to the specified waveforms.

A
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7. Tap the Help icon on the menu title for more information on the menu settings.

To stop showing cursors, open the Cursors configuration menu and set Display to Off.
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Remote access from a Web browser

You can remotely access your network-connected standard instrument (not running Windows) from a Web browser to display the
instrument user interface on a PC.

This procedure describes how to remotely access the Ul controls and screen for standard (non Windows 10) instruments. To remotely
access the Ul controls and screen for Windows 10 instruments, see the Remote access to a Windows 10 instrument topic in the Help.

Prerequisites:
+ The instrument must be connected to, and accessible from, the network to which the PC is connected. See Connect to a network
(LAN) on page 40

+ The IP address of the instrument that you want to access. To determine the instrument's IP address, select Utility > 10 in the
instrument menu bar and view the network settings in the LAN panel.

* You are accessing a standard (instrument that does not have the Windows OS option installed).

Use below procedure to remotely access the Ul controls and screen for standard (non Windows 10) instruments using e*Scope
functionality.

1. Open a Web browser on a PC connected to the same network as the instrument.

2. Enter just the instrument IP address on the URL line of the browser and press Enter. For example: 135.62.88.157. The browser
searches for and opens the Web page for the instrument.

3. Select Instrument Control (e*Scope®). The browser displays the instrument screen.
4. Use a mouse to select and interact with the instrument controls shown in the Web browser. If your remote PC or laptop has a touch
screen monitor, you can use the remote touchscreen monitor to access the instrument controls.

When you access the instrument from an e*Scope browser, you cannot directly paste text (such as path, IP address information, and so
on) from the PC to an instrument menu field. You must use an intermediate clipboard function that is available in the e*Scope application.
Use the following steps to copy text from an e*Scope-connected PC to the instrument:

1. Open a connection to the instrument using e*Scope.

Select and copy the text on your PC.

In e*Scope, press Ctrl-Alt-Shift to open the Clipboard menu.

Paste the text into the Clipboard field.

Press Ctrl-Alt-Shift to close the browser Clipboard menu.

Use e*Scope to open the instrument menu to which to paste content, and position the cursor in the field where you want to paste the
text.

Press Ctrl-V (on real keyboard or from virtual keyboard) to paste the text from the e*Scope browser clipboard to the menu field.
8. Repeat steps 4.b on page 25 through 4.g on page 25 to copy and paste other text from the PC to the instrument

o g~ wDd

~

Connect the oscilloscope to a PC using a USB cable

Use a USB cable to connect the oscilloscope directly to a PC for remote instrument control.

On the oscilloscope, select Utility > I/0 from the menu bar.

Tap USB Device Port Settings.

Confirm that the USB Device Port control is On (default setting).

Connect a USB cable from the PC to the USB Device port on the instrument.

If using the USB connection to remotely control the oscilloscope using GPIB commands, set the GPIB Talk/Listen Address for your
configuration (0 - 30).

A S
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ESD Prevention Guidelines

Electrostatic discharge (ESD) can damage oscilloscope and some probe inputs. This topic discusses how to avoid this type of damage.

Electrostatic discharge (ESD) is a concern when handling any electronic equipment. The instrument is designed with robust ESD
protection, however it is still possible that large discharges of static electricity directly into the signal input may damage the instrument. Use
the following techniques to prevent electrostatic discharge from damaging the instrument.

Discharge the static voltage from your body by wearing a grounded antistatic wrist strap while connecting and disconnecting cables,
probes, and adapters. The instrument provides a ground connection to which to attach a wrist strap (on the Probe Comp ground
connector).

A cable that is left unconnected on a bench can develop a large static charge. Discharge the static voltage from all cables before
connecting them to the instrument or device under test by momentarily grounding the center conductor of the cable, or by connecting a
50 Q termination to one end, before attaching the cable to the instrument.

Before you apply power, connect the instrument to an electrically-neutral reference point, such as earth ground. To do this, plug the
three-pronged power cord into an outlet grounded to earth ground. Grounding the oscilloscope is necessary to ensure safety and to
take accurate measurements.

If you are working with static sensitive components, ground yourself. Static electricity that builds up on your body can damage
static-sensitive components. Wear a wrist strap to safely send static charges on your body to earth ground.

The oscilloscope must share the same ground as any circuits that you plan to test.
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Maintenance

Information for periodic and corrective maintenance on the instrument.

Inspection and cleaning

Inspection and Cleaning describes how to inspect for dirt and damage. It also describes how to clean the exterior and interior of the
instrument. Inspection and cleaning are done as preventive maintenance. Preventive maintenance, when done regularly, may prevent
instrument malfunction and enhance its reliability.

Preventive maintenance consists of visually inspecting and cleaning the instrument and using general care when operating it.

How often to perform maintenance depends on the severity of the environment in which the instrument is used. A proper time to perform
preventive maintenance is just before instrument adjustment.

Exterior cleaning (other than display)

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a soft-bristle brush. If any dirt remains, use a cloth or swab dipped in
a 75% isopropyl alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do not use abrasive compounds on
any part of the chassis that may damage the chassis.

Clean the On/Standby switch using a cleaning towel dampened with deionized water. Do not spray or wet the switch itself.

CAUTION: Avoid the use of chemical cleaning agents which might damage the plastics used in this instrument. Use only
deionized water when cleaning the front-panel buttons. Use a 75% isopropy! alcohol solution as a cleaner for cabinet parts. Before
using any other type of cleaner, consult your Tektronix Service Center or representative.

Inspection - Exterior. Inspect the outside of the instrument for damage, wear, and missing parts. Immediately repair defects that could
cause personal injury or lead to further damage to the instrument.

Table 4: External inspection checklist

ltem

Inspect for

Repair action

Cabinet, front panel, and cover

Cracks, scratches, deformations, damaged
hardware

Repair or replace defective module

Front-panel knobs

Missing, damaged, or loose knobs

Repair or replace missing or defective knobs

Connectors

Broken shells, cracked insulation, and
deformed contacts. Dirt in connectors

Repair or replace defective modules. Clear
or brush out dirt

Carrying handle and cabinet feet

Correct operation

Repair or replace defective module

Accessories

Missing items or parts of items, bent pins,
broken or frayed cables, and damaged
connectors

Repair or replace damaged or missing items,
frayed cables, and defective modules

Flat panel display cleaning

Clean the flat panel display surface by gently rubbing the display with a clean-room wipe (such as Wypall Medium Duty Wipes, #05701,
available from Kimberly-Clark Corporation), or an abrasive-free cleaning cloth.

If the display is very dirty, moisten the wipeor cloth with distilled water, a 75% isopropyl alcohol solution, or standard glass cleaner, and
gently rub the display surface. Use only enough liquid to dampen the cloth or wipe. Avoid using excess force or you may damage the

display surface.

A CAUTION: Improper cleaning agents or methods can damage the flat panel display.
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+ Do not use abrasive cleaners or surface cleaners to clean the display.
+ Do not spray liquids directly on the display surface.
+ Do not scrub the display with excessive force.

CAUTION: To prevent getting moisture inside the instrument during external cleaning, do not spray any cleaning solutions directly
onto the screen or instrument.

Check for common problems

Use the following table to help isolate possible failures. The table lists problems and possible causes. The list is not exhaustive, but it may
help you eliminate a problem that is quick to fix, such as a loose power cord.

Table 5: Failure symptoms and possible causes

Symptom Possible cause(s)
Instrument will not power on Power cord not plugged in.
Faulty power supply.

Defective micro-controller assembly.

Instrument powers on, but one or more fans will not operate Faulty fan power cable.

Fan power cable not connected to circuit board.

Defective fan .

Faulty power supply.

One or more defective point of load regulators.

Flat-panel display blank or has streaks in display Faulty LCD screen or video circuitry.

Service the instrument

For more information on troubleshooting, maintenance, and replacing parts on your instrument contact a Tektronix Service Center.

Returning the instrument for service

When repacking the instrument for shipment, use the original packaging. If the packaging is unavailable or unfit for use, contact your local
Tektronix representative to obtain new packaging.

Seal the shipping carton with an industrial stapler or strapping tape.

Before returning the instrument for service, contact the Service Center to get an RMA (return material authorization) number, and any
return or shipping information you may need.

If the instrument is being shipped to a Tektronix Service Center, enclose the following information:
«  The RMA number.

+ The owner's address.

+ Name and phone number of a contact person.

+ Type and serial number of the instrument.

+ Reason for returning.

« A complete description of the required service.

Mark the address of the Tektronix Service Center and the return address on the shipping carton in two prominent locations.
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altitude range 16

humidity range 16

temperature range 16
operating power requirements 16
options

install an option 15

options (continued)
option license file 15
overlay mode (waveforms) 52

P

Pan 35

panels, menu 34
persistence, waveform 52
Plot button 24

power requirements 16
power-on test results 17
preventing ESD 57

probe deskew, set 43
probe parameters, set 43
probes, connecting 17

R

rack mount kit information 17
record view, waveform 26
reference waveforms 46
remote access (e*Scope) 56
remote access (\Web-based) 56
requirements

altitude 16

environment 16

humidity 16

power 16

signal inputs 17

temperature 16
Results bar 24
Results Table button 24
run signal path compensation 39

S

scale buttons, badge 27
search badge 27
Search button 24
searching for events 51
set
clock format (12/24 hr) 38
GPIB talk/listen address 41, 56
probe deskew 43
probe parameters 43
time zone 38
Settings bar 24
show a measurement 47
signal input levels 17
SPC (signal path compensation) 39
stacked mode (waveforms) 52
Stand 23

T

time zone, how to set 38
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